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Installation and Setup

System Requirements

Windows 98, Windows NT 4.0 with SP4 or later, Windows 2000, Windows XP
Intel Pentium III or higher processor

128 MB RAM
10 MB of hard disk space for installation

MacOS 7.5.5 or greater

PowerPC processor

64 MB RAM

10 MB of hard disk space for installation

Mac OS X
Power Mac G3, PowerBook G3 or higher; iMac, iBook computer

128 MB RAM
10 MB of hard disk space for installation

Internet connection and Microsoft or Netscape Web browser required for installation

Frontier is built around an integrated object database and doesn't require any additional database
software to run. Frontier also has an built-in Web server, but can also work with IIS, Apache and other
Web servers using static rendering in Manila.

Installing Frontier

After downloading the Frontier software package, you can follow the instructions below to complete
the install.

Pre-installation

You should install Frontier to a drive with enough free disk space to save your websites and other
data. It's not advised to move Frontier to another path/drive once it's installed.

If you have another web server running on the machine you plan to install Frontier on, please read the
Using Frontier alongside other web servers section of the guide.



http://frontier.userland.com/stories/storyReader$1132
http://frontier.userland.com/stories/storyReader$1003
http://frontier.userland.com/manila/staticRendering/
http://frontier.userland.com/frontierWithOtherServers

Windows
Run the installer, Frontier90Setup.exe, and follow the instructions in the setup dialogs.
At the end of the installation process, the installer will (optionally) launch the program for you.

To uninstall: From the Start menu, choose Programs->UserLand->UserLand Frontier Uninstaller, and
click Yes in the confirmation dialog.

Macintosh OS X

Extract the downloaded archive, double-click the extracted disk image to mount it on your desktop,
and copy the Frontier folder into the Applications folder.

Make sure that your web browser is running, and then double-click the UserLand Frontier application
icon.

To Uninstall: Drag the UserLand Frontier folder to the Trash.

MacOS Classic

Unstuff the archive if it hasn't been unstuffed automatically, and launch UserLand Frontier 9.0
Installer. Follow the instructions in the installer. At the end of the installation process, it will

(optionally) launch the program for you.

To Uninstall: Drag the UserLand Frontier folder to the Trash.
Setting up Frontier
After installing, launch the Frontier application and your Web browser will open with the Frontier

Setup page.

If your server is behind a proxy server, you should first complete the form at the bottom of the setup
page with your proxy server details.

Enter the contact information for the webmaster, SMTP server and the administrator password. Click
the Submit button.

Login to the Frontier Admin Site

You will then be asked to login to the Frontier Admin website, enter the webmaster's email address
and the admin password.



Default Manila sites

After setting up Frontier, your server will automatically be setup with three default Manila sites: the
Home site, the Frontier Admin website and the Create a Manila Site.

Home site

This is your default Manila site that serves as the top-level homepage to your server. You can edit the
site and make it an informational site for users using your server.

Frontier Admin site

The Frontier Admin website is where you can manage and check the status of your server.
Create a Manila Site

The Create a Manila site is where your users can create new sites.

Note: You can restrict who can create new Manila sites by choosing Settings and then the Hosting
settings link in the Admin Site.



Manila Basics

Creating a new site

You can create new Manila sites by logging into the Admin Site or by going to the Create a Manila
Site which was created when you setup Radio.

Steps

1. Open the Admin Site and at the top of the page you should see a link: "create a new site." Click it.

2. From there, you can choose the name of your site, enter your name, email address and password
and choose a Theme for your site.

You can also preview the different Themes from this page.

Finding Create a Manila Site
You can invite your users to visit this page to create their site by filling out the form.

To find the Create a Manila Site, go to the Admin Site home page and then click the globe icon to the
left of the Create a Manila Site link.

Logging into your site

Manila includes a built-in membership system that lets you maintain a database of members to send
out email bulletins, restrict posting access to the discussion group and to allow selected members to
become editors of the site.

To start editing and configuring your Manila site, you need to login.



Steps

1. After you create your new site, your browser will open your new site.

2. Click the Login link.

3. Enter your email address and password you entered when you created the site. Click the Login
button.

Notes

If you forgot your password, you can just enter your email address and leave the password field blank.
Manila will send a copy of your password in an email.

Editing the home page
After you have logged into your site, you will see several new links and buttons on your home page
since you are a Managing Editor.

From the Editors Only menu at the top of the page, you can create new stories, post pictures or
configure your site.

Below the home page text, you will see the Edit this Page button where you can edit the text on the
page.

Steps
1. Click the Edit this Page button.

2. You can edit the title of the page or change the text. When you are finished editing, click the Post
Changes button.

3. The home page will load in your browser with any modifications you made.

Flipping the home page

If the home page has a calendar, the current home page story can be archived and a new, empty one
created in a single operation. This is called "flipping" the home page.



Steps

1. Click the Flip Home Page button.

2. Click OK to confirm that you want to flip the home page..

3. When Home Page appears, it will have the same Title as before but it will be empty.

4. To add new content, use the Edit This Page button or the Update Home Page button if you have an
editing form on your home page.

Adding a picture

Follow the steps below to add a picture to your Manila site.

Steps

1. Click the Pictures link in the Editors Only menu at the top of the page.
2. Click the Create a New Picture link at the bottom of the pictures list.
3. Choose a title for your picture.

4. Click the Browse button and locate the image on your computer

5. You can add some text to describe the image, which will be used for the ALT tag to be more
accessible for people with disabilities.

6. Click the Submit button.

Adding a story

Follow the steps below to add a story to your Manila site. Each story can be a different page on your
site like the default story that has the text for your About page.

Steps

1. Click the Stories link in the Editors Only menu at the top of the page.

2. Click the Create a New Story link at the bottom of the stories list.



3. Choose a title for your story.
4. You can then add the text for your story.

5. When you are finished, click the Submit button.

Using shortcuts

Shortcuts are an easy way to include links and pictures in your pages. Instead of having to find the
URL, you can add a link or include a picture in a page by enclosing its shortcut name inside "double
quotes".

When you create a story, post a gem or add a picture, Manila is enabled by default to automatically
create shortcuts for them using the title.

Managing shortcuts

The managing editor for the site can also add and delete shortcuts from the Shortcuts page. When you
manually add a shortcut, you can also enter any URL that you would like to use with the shortcut.

Changing your password

Follow the steps below to change your password for your membership to your Manila site.
Steps

1. You can view the change password page for your site by adding "/member/changePassword" to the
URL of your Manila site:

eg. http://yourdomain.com/mysite/member/changePassword

2. Enter your current password into the Password field, and your new password into the New
Password and Repeat fields.

3. Click the Change Password button.



Signing out

There may be times when you want to sign out of a Manila site, either because you're using a public
location to work on the site or perhaps you want to see what it looks like to a visitor.

From any page you can click on the Sign Out link or if you are an editor you can click the Logoff link
in the Editors Only menu. Click Sign Out to confirm that you want to, and Manila will return you to
the page you were just looking at.

But now you'll see the page without the Editors Only links, Edit This Page buttons and so on. When
you're ready to edit the site again, just login and you're away.



Site Administration

Customizing a site

From the Prefs menu on your Manila site, you can customize all aspects of your Manila site.
Appearances

This is where you make changes to the basic look of a Manila site, such as the Site Name, the Tag
Line, many of the colors (background, text and so on), whether or not a Calendar appears on the
Home Page, whether or not Bylines appear beneath Stories and whether there's a Create New Topic
link on the DG page.

Editorial

This is where you set up who the Managing and Contributing Editors will be, when email
notifications are sent and to who, and whether Shortcuts are created automatically for new Stories.

Legal Tags

Manila lets you decide how much HTML your Members and Editors can use. In the Legal Tags
Preferences you can disable HTML tags and they'll be converted to ordinary text instead of changing
the look of your pages.

Searching

A Manila site can be made searchable by setting up information about the search engine server. (Note:
no search engine servers are available yet).

Syndication

One powerful way to reach a larger audience is through syndication. In simple terms, Manila can
automatically create a simple outline of the news on your Home Page whenever it changes. If you
register your site with another site that supports syndication, your news will appear on their site. The
Syndication Preference is where you set up the news outline for your site.

Membership
This Preference is where you enable Membership for the site, set up what kind of access Members and

visitors have, layout what your plain text and HTML email Bulletins will look like and change where
the Membership pages, such as Login and Profiles, are found.



Confirmation

The Confirmation Preference is where you set up the email and welcome page that new Members see
when they join.

Outlines

You can allow Radio UserLand to edit messages, stories, and templates on your Manila site. You can
also customize the templates for directories and slides that can be generated on your site using Radio.

News Items

News Items are a new way of working on a Manila home page. Instead of working on individual days,
you create, edit, and post individual News Items. If you enable this feature, instead of saying how
many days are displayed on a home page, you say how many News Items are.

Plug-ins

The Plug-ins Preference is where you control custom features on your your Manila site. A plug-in is a
separate program that works with Manila to give it new capabilities. Because they're not part of
Manila, the plug-ins you have depends on the Manila host you're using. You can enable and disable
plug-ins, learn more about them and configure them from this page.

Themes

You can use themes to easily change the appearance of your entire site. UserLand and other designers
have released pre-built themes which contain customized templates and other settings.

Discussion Group

This Preference is where you can customize the appearance and some setting on how the discussion
group on your Manila site works.

Discussion Group Themes

Like the themes feature for your Manila site, you can change the appearance of your discussion group
using a discussion group theme.



Advanced

Last but certainly not least, the Advanced Preference is where the power user tools are found. From
here you control the following:

Navigation - automated navigation links

Template - the master Web page that all pages are built from

Home Page Template - you can use a second template that is only used for your home page
Print-Friendly Template - you can customize the appearance of print-friendly pages
Cascading Style Sheet - CSS code added to all your pages

JavaScript - JavaScript code added to all your pages

Site Structure - readable URLs, automated TOCs and Next/Prev links

Custom Prefs - select the Member registration information

News Day Template - the look of the Home Page when more than one Home Page Story is shown
Navigation Appearance - the appearance of the Navigation links

Calendar Appearance - the design of the Calendar

Join Now Members Box - the design of the Members Box before login

Sign Out Members Box - the design of the Members Box after login

Theme - you can choose to share the design of your site as a Theme that other Manila users can
download



Searching a site

If you have enabled the search engine on your server and setup the Searching preferences page, your
Manila site will automatically be setup with a search page.

Steps

1. You can view a list of all the stats page for your site by adding "/search" to the URL of your Manila
site:

eg. http://yourdomain.com/mysite/search
searchThisSite macro

If you want to add a search box to another page on your site, you can use the {searchThisSite ()}
macro.

How to call it
{searchThisSite (buttontext:"Search", fIThisSiteOnly:true, thisSiteOnlyCheckText:"This site only")}
buttontext is a string that sets the text of the button in the search form.

flThisSiteOnly is a boolean that includes a checkbox in the search form that restricts the search to the
site.

thisSiteOnlyCheckText is a string that sets the text beside the checkbox.

Viewing site stats

Along with the option of logging of all HTTP traffic on your server, Manila logs stats for each site on
your server: Hourly Hits, Members, Most Read Messages and Referers.

Steps

1. You can view a list of all the stats page for your site by adding "/stats" to the URL of your Manila
site:

eg. http://yourdomain.com/mysite/stats



Hourly Hits
Shows the hits per hour for the last 24 hours.
Members

A list of all members of the site. You can make the members list private, viewable only by managing
editors, on the Membership prefs page.

Most Read Messages

Shows the top fifty most read messages on your site.

Referers

Shows referers to your site for the last 24 hours. A referer is the URL of a page that links to a page on
your site. When someone follows a link to visit your site, that person's browser sends the URL of the
page they were on to your site.

See also

ManilaNewbies: Referer stats

ManilaNewbies: Hits by Hours stats

Editorial roles

Members of a Manila site can be assigned an editorial role if you want to grant them access to write
stories or modify the appearance of your site. The site owner is automatically added as a Managing
editor of the site and you can have as many editors as you like for each site.

Managing Editor

Managing Editors are Members with the same privileges as the original site owne with the complete
Editor's Only links, including the Prefs, Admin and Bulletins links.

Contributing Editor
When Contributing editors log in, they see a limited version of the Editor's Only links, without the

Prefs, Admin and Bulletins links. Other than those areas, and not being able to edit other people's
Messages and Stories, they have the same access as a Managing Editor.


http://manilanewbies.userland.com/stories/storyReader$4580
http://manilanewbies.userland.com/stories/storyReader$4633

Content Editor
The Content Editor, is mid-way between the managing and contributing editor roles. The Content
Editor can edit all the stories, pictures, and messages on a site like a Managing Editor but can't edit

templates and set the various site preferences

Unlike contributing editors, they can edit content written by other people.

Managing members

From the Admin page of your Manila site you can add and block members from your site. Click the
Admin link in the Editors Only menu to open the Admin page.

Add a new member

To add a single member, enter the name, email address and password for the member. Then choose
their member privileges and if they should receive an email notification. Click the Add Member
button.

Add multiple members

You can signup mulitple new members to your site by entering a list of email addresses into the text
area, choosing their member privileges and then clicking the Add Members button.

Email addresses can be separated with spaces, carriage returns, tabs or commas.

Each member will automatically be assigned a random password that they will receive in a welcome
message sent to each email address that is signed up.

To block a member

Blocking a Member denies them access to any part of your site. When they try to view any page, they
see a message telling them they have been blocked. They will have access to any areas of your site
available to the public if they log out.

Enter the email address of the member you want to block and then click the Block Member button.
To unblock a member, enter their email address and click the Unblock Member button.

To delete a member

To delete a member from your site, enter their email address and click the Delete Member button.



Bulletins

Bulletins provide an easy method for a Managing Editor to send email to Members. When people sign
up as Members of a Manila site, they choose whether to receive Bulletins and whether they want the
plain text or HTML version. Manila has a simple Web interface to create, preview and send a
Bulletin, and a way to check the recipients.

Steps

1. Click the Bulletins link in the Editors Only menu at the top of the page.

2. Enter the Subject and Text information.

3. Click the Preview button to see what the plain text and HTML Bulletins will look like.

4. Click the Edit button to change the Bulletin content, or click the Send button to send it.
Changing the site's appearance
You can customize the colors and template for a site from the Preferences page or you can choose a

pre-built Theme.

From the Preferences page you can change everything that defines the look of a Manila site, including
the templates, Cascading Style Sheet, JavaScript, colors, and so on.

A theme takes all the appearance settings for a site and saves them to a theme file so that other people
can apply to their sites.

Steps

1. If you want to see what a theme looks like, click the name of the theme -- it's a link to the site that
the theme comes from. Click the Back button in your browser to come back to the Themes page.

2. The radio button next to the last theme you applied is always checked. If you've never applied a
theme, the Default theme will be checked.

3. To choose a theme for your site, click the radio button next to the theme, then click the Apply
Theme button. Your site will then look like that theme.



Important Note
When you apply a theme, your templates and colors are over-written with those of the theme.

You can then go ahead and edit your templates and site prefs normally, but now they're based on the
theme's templates and prefs.

Browser-based editor

Manila by default enables support for a WYSIWY G browser-based editing tool that is available to
users using Microsoft Internet Explorer 5 or greater on Windows.

Or you can choose to use the HTML Tags editor which includes a formatting toolbar or plain text area
if you are more comfortable writing your own HTML by hand.

Steps
1. Click the Prefs link in the Editors Only menu at the top of the page.
2. Click the Editorial link.

3. Scroll down to "MSIE 5/Windows Editing Tool" and choose which editing tool you want to use in
the drop down box.

4. Click the Submit button at the bottom of the page.

Site Structure

The Site Structure area is where you can create a kind of map between virtual folders or files and
actual Messages. This feature can be used to complement Manila's built-in system for assigning URLs
to Stories, Message and Pictures.

Standard Manila URLSs look like these:
http://yourdomai n. coni di scuss/ nsgReader $123
http://yourdomai n. coni stori es/ st oryReader $123
http://yourdomai n. cont pi ct ures/ vi ewer $123

These URLs, combined with Shortcuts and Navigation, are often all that's needed on a site. In cases
where more meaningful or memorable URLs are needed, the Site Structure feature is the answer.



A Simple Example

The example below shows a simple Site Structure.
<hi er ar chy>

<story pat hname="faq" nmsgNum="3"/>
<story pat hname="f eedback” nmsgNum="2"/>
</ hi erarchy>

This effectively tells Manila to act as follows:

If a browser asks for "/faq", show Message number 3
If a browser asks for "/feedback", show Message number 2

If our example site were located at htt p: // 192. 168. 0. 1/, the Site Structure above would enable the
following URLs:

http://192.168. 0. 1/ f aq (display Message number 3 as a Story)
http://192.168. 0. 1/ f eedback (display Message number 2 as a Story)

Site Structure XML

The Site Structure is created with a simple XML document. There's one XML element, <hi er ar chy>,
that contains all of the structure information. It begins with a <hi er ar chy> tag and ends with a
</ hi er ar chy> tag. If more than one <hi er ar chy> element appears, all but the first one are ignored.

Inside the <hi er ar chy> element, you can have the following elements:

<story>
<cat egor y>
<descri pti on>

A <st ory> element maps a file name to a particular Message, while a <cat egor y> element maps a
directory name to a set of Messages. You can have as many <st or y> and <cat egor y> elements as
you need, and <cat egor y> elements can be nested (appear inside on another). If a <descri pti on>
element appears inside a <st or y> element, Manila will use it when building automatic Story lists.

A <st ory> element can work with only one tag by using a closing "/ " before last angle bracket (e.g.,
<st ory/ >). If there's a <descri pti on> element inside the <st or y>, then a closing </ st or y> tag is
required instead. All <cat egor y> elements need a closing </ cat egor y> tag, and <descri pti on>
elements must be closed in the same way.



A <st ory> describes a virtual file using the following format:
<story nane="abc" pat hnanme="def" nsgnun¥"xyz"/>

nanme Optional text describing the Story (with or without spaces)
pat hnane The virtual name of the Story (no spaces, with or without an extension such as ".html")
msgnumThe number of the Message to display (Story or Picture)

A <cat egor y> describes a virtual folder using the following format:
<cat egory nane="abc" pat hnane="def" nmsgnume"xyz">

</ cat egory>

nanme Optional text describing the Category (with or without spaces)

pat hname The virtual name of the Category (no spaces)

msgnumThe optional number of the Message (Story or Picture) to display as a default page for the
folder

A <descri pti on> adds explanatory text (displayed in automated Story lists built by Manila) in this

format:

<story nane="abc" pat hname="def" nsgnun¥"xyz">
<descri pti on>

This is a great story!

</ descri ption>

</story>

Reserved Names

Manila reserves certain names for its own use, so it's best to avoid using any of the following for a top
level Category or Story:

2002 (and any ot her past cal endar year the site was in use)
adnmi n

bull etins
commrent s

def aul t
directory

di scuss

downl oadDi scussThene
downl cadMySite
downl oadThen®e
edi t HonePage
gens

nai |

nenber
newsl t ens

pi cture

pi ctures

prefs

profiles
random

sl i des

stats

stories

wap

xm



XML Syntax Errors

When there's a syntax error in your XML, Manila returns the form with the error shown above it. No
changes are made to the Site Structure when this happens. The most common errors include
unnecessary or missing </ st or y> and <st or y/ > tags, leaving out the closing </ cat egor y> tag and
omitting the <hi er ar chy> element.

Custody

Manila keeps track of the Stories, Messages and Pictures being edited so each item can only be edited
by one person at a time.

Checked Out Items

As soon as someone clicks Edit This Page, Manila marks that item as being "checked out", meaning
someone is working on it. Manila keeps a list of checked out items that includes the Message number,
the name of the person editing each one and the time they started editing. A Managing Editor can see
this list in the Custody area of the Admin page, which looks like this:

If someone tries to edit an item on the checked out list, they see a Message explaining that it's already
being edited. As soon as the person working on it posts their changes, Manila removes the item from
the checked out list and it's available to the whoever who wants it.

Manila also tracks the time spent editing an item and will automatically check it back in again after a
certain time. This is in case someone starts to edit and changes their mind, or perhaps goes home for
the day after starting to edit!

A Managing Editor can change the editing time limit using the Editorial Preferences; by default it's
240 minutes (4 hours). A Managing Editor can also force items to be checked in via the Custody area
of the Admin page.

You can see which messages and advanced items are checked out, and you can force a check-in of any
message or advanced item.

When a message or advanced item is being edited, the editor has custody of that item. You can specify
how many minutes must elapse before custody of a message or advanced item expires.



Server Administration

Frontier Admin website

The Status Center flows down the right edge of the Admin site home page. It lets you see at a glance
what kind of traffic the server is getting, and what disk and memory resources Frontier is using. In
addition, Tools from UserLand and other developers can add their own information to this display.

The Admin website includes a site-level overview which you can use to get detailed information about
any Manila site on the server.

The site-level administrative pages also include managerial functions for making backups, moving
sites around, installing and un-installing sites, and managing the search engine index for a given site.

The Settings pages in the Admin site are for managing global settings that apply at a server-wide
level. You can add or remove administrative users, set security settings, configure the search engine,
set up virtual domain hosting, manage WebEdit users and objects, and configure backups and logging
functions.

The Readouts page provides an overview of server activity. It includes recent log entries for all
enabled server logs, an overview of open databases, and hard disk status. From the Readouts page,

you can click through to the full version of any log.

The Maintenance page provides commonly used server-maintenance functions: You can update your
software, make immediate backups of your sites, and reset or re-index the search engine.

Site-level administrative pages
From the Frontier Admin site home page, you can get a site-level overview to find out detailed
information about each Manila site on the server.

The manage site pages also include managerial functions for making backups, moving sites around,
installing and un-installing sites, and managing the search engine index for a given site.

Disable site
You can disable a site so the server will stop serving the site, but it will still be listed on the Frontier

Admin site home page. Disabled sites can be enabled at any time, by clicking the enable link on the
Manage site page. You also have the option of deleting a site from your server.



Change URL

Sometimes you might make a change on a server that requires changing the URL of an existing
Manila site. You can change the URL the site is served using this command.

Say, for instance, there was a DNS change. Your server is no longer abc.myserver.com, it's now
xyz.myserver.com. But the Manila site you're running still thinks it's on abc.myserver.com.

In other words, the site was at http://abc.myserver.com/MyFirstSite/, but now it's at
http://xyz.myserver.com/MyFirstSite/.

You want your Manila site to know that its base URL has changed. You want all the links fixed.
Make private

You can restrict a Manila site to just Contributing, Managing and Content Editors. With this setup,
only two Web pages are available to anyone other than Editors who have logged in. One is a plain
Web page informing the visitor that site access is restricted to Editors only (the name and content of

this page can be changed). The second accessible page is the standard Manila login page.

You can make an Editors Only site public again, by clicking the make public link on the Manage site
page.

Change membership group

Normally when a new Manila site is created, it gets its own membership group. This means that for
every site, you have to become a member and login.

You can setup a site to use an existing membership group so that you can login once and your a

member of all the sites that share that membership group.

Note: Changing the membership group of an existing site doesn't attempt to reconcile the membership
data between the two sites.

Backups

You can enable/disable the nightly backup of the Manila site from this page. Even if you don't enable
the nightly backup the site, you can do a one time backup by clicking the backup now link.

Enable search
After you have enabled the search engine from the Settings page on the Admin site, you can enable

searching for your Manila site on the manage site page. Editors of the site can also enable search from
the Search prefs page for the site.



On the manage site page, you can also enable indexing of the discussion group and run a manual
index of the entire site if the search engine hasn't always been running.

Editors/Members

The Editors and Members section of the manage site page allow you to jump to the Editorial Prefs and
Admin page for the site to manage editors and members of the site. You need to be signed up as a
Managing Editor to view the page and make any changes.

Plugins

You can check what plugins are installed and if they are enabled/disabled on the site.

Stats

Listing of hits all-time and today and most read messages.

Getting updates to Frontier and Manila

In between releases of Frontier, we release bug fixes and new features via the root updates process.

Frontier can automatically connect to a server at UserLand each night, to get new features and bug
fixes. Only those parts that have changed since the last updated will be installed.

If you want to update right away, go to the Frontier Admin site and open the Maintenance page and
click the Update Now button.

Reviewing new updates

If you have logging of root updates enabled, you can view all root updates downloaded today on the
Root Updates Log page on the Frontier Admin site.



http://127.0.0.1:5336/rootUpdatesLog

Backups

Frontier includes a built-in backups system to make nightly backups of your Manila sites, guest
databases and discussion groups.

Manila site backup

The Manila site backup feature lets you choose important sites to be backed up nightly, using the
same backup system used at UserLand.

Backups are incremental: Sites for which backups are enabled will have any new or changed parts
backed up every night, and an email report will be sent to the server administrator(s).

Any site, even ones which aren't set for automatic backups, can be backed up at any time through the
administrative page for the site.

Guest Databases backup
Frontier uses guest databases to store information about your server and Manila sites. There's a
preference to save all changed databases every minute, it's strong recommended that you leave this

backup option enabled.

The guest databases backup feature lets you setup Frontier to make a nightly backup of all the
databases used on your server.

Discussion group archives in XML
Unless you need to access the discussion archive files in the XML format, you can leave this feature

disabled. Your discussion groups will be backed up if you enable the Guest Databases backup and will
also be backed up for any Manila sites with backups enabled.

Server maintenance

There are a few maintenance tasks that you should follow with your Frontier/Manila server.
Compacting roots

As a Frontier object database file, Frontier.root, gets older, freed disk blocks are added to an internal
list called the "avail list." As this list gets long, disk-based operations can slow down significantly.

You can periodically freshen your database with the Save A Copy command in the File Menu on a
regular basis or when you notice a guest database is quite large (a few hundred MB).
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First, shut down the Web server by choosing Web->Web Server->Stop while you compact the root
files.

Choose the command, save to Frontier.fresh.root. Take a short break. When it's finished, quit Frontier,
move Frontier.root to a safe place, and rename Frontier.fresh.root to Frontier.root. Relaunch Frontier.
Things should run faster now.

You can turn the Web server back on and trash the original Frontier.root. The new one contains all the
information in the old one.

If you want to get an idea of the condition of your object database, enter window.dbStats () into the
Quick Script window. A report appears in a separate window. The third line in the stats window tells
you how many nodes are on the avail list. The fewer the better.

Save A Copy will also compact the file, squeezing out all the unused space between disk blocks. The
resulting file will be smaller than the original file.

Log and backup files

It's recommended that you leave enough free drive space on the drive Frontier is installed. If you have
enabled any of the logging and statistics or nightly backup of guest databases on your server and you
have limited hard drive space where Frontier is installed, you may need to delete or move these files
periodically.

Log files are by default saved to the Guest Databases\ops\logs folder. And backup of guest databases
are saved to Guest Databases\ops\backups.

Backups

You may want to make periodic backups of your Frontier folder to another machine or other media. If
you want to backup the entire Frontier folder, turn off the Frontier Web server while you copy the

contents of the folder.

You can also leave your Frontier server and just backup your guest databases from the Guest
Databases\ops\backups if you have enabled the option to backup your guest databases nightly.

Membership
Normally when a new Manila site is created, it gets its own membership group. This means that for
every site, you have to become a member and login.

When sites share a membership group, this means that you can join once, login once, and you're a
member of all the sites that share that membership group.



Sharing a membership group

Perhaps you're building an intranet with Manila. You might create lots of sites, and give each
department in your company control over their own site.

However, most people won't think of the intranet as lots of small sites, they'll think of it as one big
site. They'd be right to think so. And they'd be right to not want to sign up again for each site.

Better to sign up just once -- but be a member of all the sites.

Or maybe you're hosting websites for a school, or you're hosting weblogs for all the people in your
non-profit organization. Maybe your company's Web presence is made up of many Manila sites.

The idea is to make it so people don't have to sign up again every time they turn around. If you have
such a need, then this feature is for you.

Steps

1. Open the Admin Site and at the top of the page click the Settings link.

2. Click the Hosting link.

3. Check the box so new sites to share their membership group with the hosting site.

Important: If you use shared membership, you should not disable or delete any site that is using shared
membership.

Existing sites
If you open the manage site page for the site, you can change the membership group used by the site.
How it works

When a new site is created, it uses the same membership group as the site with the Create-a-Manila
form.

In addition, the URLSs for logging in and out, viewing preferences, and viewing membership profiles
point to the site with the Create-a-Manila-Site form.



This way there's just one place for logging in and out, one place to set membership prefs, one place to
view profiles, for all the new sites that are created.

This all happens automatically.
See also

members.root

Hosting

The hosting preferences let you choose the setup options for new sites on your server.
Who can create new sites

By default, anybody can create new Manila sites. But you may prefer to limit this to the editors of the
Create a Manila Site.

If you'd rather restrict who can create sites even more, you can make it so that new sites can only be
created via the Admin site. All you have to do is remove the Create a Manila Site macro from your
hosting site. (Go there in your web browser, click Edit this Page, delete the macro.)

Top-level sites and sub-sites

If you want top-level sites -- sites of the form siteName.myserver.com -- then use the popup menu to
switch to top-level sites.

Important note: top-level sites won't work unless you have a * DNS mapping pointing to your server.
What this means is that anyName.myserver.com will resolve to the IP address of your server.

When changing from sub-sites to top-level sites, you must change the base domain.

It should be of the form .myserver.com. Sites will be created at siteName.myserver.com. Note the
period in front of the name.

To switch from top-level sites back to sub-sites, it's important to switch the base domain back to a
domain of the form www.myserver.com. (Use the actual domain name of your machine, of course.)
Note that there is no period in front of the name.

Shared membership

When sites share a membership group, this means that you can join once, login once, and you're a
member of all the sites that share that membership group.
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If you only want a certain set of sites to share membership, you can change the membership for an
individual site on the manage site page.

Create new site in a database named

When a new Manila website is created, it's stored in a database containing other Manila sites. By
default, this database is manilaWebsites.root.

As manilaWebsites.root grows, it's a good idea to "flip" -- to start using another database for new
Manila sites.

One of the reasons do this is that there's a 2GB limit on the size of databases. You should flip well
before you reach that limit, so your sites have room to grow.

Create a new guest database via the File menu. Give it a name like manilaWebsites2.root.

With the new database in front, choose Add to user.databases... from the Server menu. This will
ensure that the database is opened automatically when Frontier starts up.

Then change the name on the Hosting preferences page.
New site defaults

You can also set the default site language, editing tool and customize the home page text that will
appear on all new sites.

Static rendering

Static rendering means creating .html files from your Manila website and saving them to disk. This
creates a traditional website, the kind that can be served by non-Manila servers such as Apache,
WebSTAR, and IIS, servers that are optimized for serving static files from disk. Your static server
doesn't know about Manila -- it doesn't need to.

Manila does the static rendering for you. It's a feature you can turn on and configure.

What you end up with is two websites: the Manila site where you work on your site, and the static site
that exists as files on disk.

Why static rendering?

There are two main reasons to use the feature. One or both may apply to you -- or you may have other
reasons.



1. Performance

There is a simple reason why a site that's been rendered to disk will often load faster than the Manila
version. In a static site, the pages have been pre-built. In Manila, pages are built on the fly, for every
request. This means a static server is doing much less work than a Manila server: all it has to do is
read a file and return the contents to the browser. Latency -- the time it takes before the server starts
returning data to the browser -- is thus lower.

2. Staging

You may want a private and a public site. You can use the Manila site as your private site and the
static site as your public site. When a page is ready to "go live" -- when it's ready to be rendered to the
static server -- you can tell Manila to render the page.

This allows you to iterate over your copy without making all your edits public. You can create a new
page and edit it until it's the way you want it, then render it. Later you can edit again, and re-render it
once you're finished editing.

What gets rendered

The Manila version of your site may or may not be public. So rather than talk about public and private
sections of your site, this document refers to the render-able sections of your site.

There are three types of pages that can be rendered: home pages, former home pages (back issues)
available through the home page calendar, and pages defined in your site structure.

Other pages -- your discussion group, your prefs pages, and so on -- are not rendered. Some of these
don't make sense on a static server, some are highly dynamic and can't be rendered.

This division between render-able pages and non-render-able pages allows you to define what goes
onto the static server and what doesn't. Remember that any piece of content can be added to the site
structure, so you have control over what gets rendered to the static server.

Static rendering preferences

Static rendering is a feature the server manager can enable or disable for the entire server. If you're a
server manager, see How to Set Up Static Rendering for Manila Sites.

If static rendering is enabled on the server, then you the managing editor of a Manila site can choose
whether or not to use it.

In the site prefs section of your site is a new link called Rendering. Click it to go to the prefs page for
static rendering.

There are three questions on that page. The first asks if you want to enable static rendering for your
site.
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The second question asks if you want pages rendered when they're new or changed. If you're using
this feature for performance reasons, then choose Yes. This way the static version of your site will
always be in synch with the Manila version.

The third question asks if you want a Render this Page button on render-able pages. If you're using
Manila as a staging server, then this is your best choice. This way you control when pages are
rendered -- you can edit pages without triggering a static rendering. Pages get rendered only when you
click the Render this Page button.

You can choose Yes for both options: you may want pages to be automatically rendered, but also have
the option to re-render a page at will.

Rendering an entire site
When you first turn on static rendering, you will probably want to render your entire site at once.

To do so, go to the Admin page. The top item in the page is labelled Static Rendering: click the
Render this Site button.

The next page is a confirmation page, which makes sure you really want to render the entire site. The
confirmation page also reminds you of the URL of your static site.

Depending on the size of your site, it may take from a few seconds to a few minutes to render the
entire site. The page doesn't return until the entire site has been rendered. It's much like sending
bulletins -- if you have lots of subscribers, it may take a little while before the page returns telling you
who bulletins went to. In this case, the returned page is a report listing all the pages that were rendered
to disk. You can click on any URL to visit the static version of the page.

You of course want to render your entire site when you first set up static rendering. But there are other
times, too -- such as when you make a major change to your template. The static version of your site
will need to be re-rendered to use the edited template.

Workflow

You've got two versions of your site. The Manila site has Edit this Page buttons, the static version
does not.

You also have two URLSs -- perhaps the static version is at www.mysite.com and the Manila version is
at editorial. mysite.com.

It's a good idea to bookmark both sites.

There's a new feature in your Manila site designed to make it easier to work on the home page -- the
editHomePage page.



In your Manila site is a new /editHomePage page -- at http://editorial. mysite.com/editHomePage, for
instance. When you go to this page you have your standard editing box. It's the same thing you see
when you click Edit this Page.

This page always allows you to edit the current home page. It's another good page to bookmark -- or
put in your browser's toolbar, so it's always one click away.

When you click the Post Changes button, one of two things happen, depending on your prefs. Either
the Manila version only of your home page is updated, or the Manila version and the static version are
both updated.

If you have automatic rendering turned on, then the static version is updated. The next page you see is
the static version of your home page.

If you don't have automatic rendering turned on, the next page you see is the Manila version of your
home page.

Render this Page

If you're using Manila as a staging server, then you want pages rendered only at your command.
That's what the Render this Page button is for.

It appears only on pages that are render-able. (Home pages, old home pages, site structure pages.)
When you click the Render this Page button, the static version of the page gets rendered, and the next
page you see in your browser is the static version. You can use the back button to get back to the
Manila version of the page.

More about automatic rendering

Automatic rendering has some additional features designed to ensure that the static version of your
site is in synch.

When you update your home page, the calendar version of your home page is also re-rendered.

Even when you use Manila Express your home page is automatically re-rendered.

Static pictures

Some servers are optimized for brains -- they're good at serving dynamic sites. Frontier is such a
server. Other servers are optimized for brawn -- they're good at serving static files from disk. Apache,
WebSTAR, IIS, and others are examples.

When serving pictures, you don't want a smart server -- you want a server like Apache that excels at
serving pictures.



You can tell Frontier to write pictures to disk, to a shared volume, where the pictures can be served by
a server optimized for serving picture files.

It's easy to set up, too. If you have a static server already set up, and a file-sharing connection, all you
have to do is tell Frontier where to store the pictures.

Enabling Static Pictures

From the Static Files settings page in the Frontier Admin site, the first setting asks if you want to write
pictures to disk. If yes, then Frontier will write pictures to disk as they're uploaded to a Manila site.

The next setting asks for the location of the folder where pictures should go. Frontier will create a
folder inside this folder for each site, so each site's pictures are stored separately.

The last setting asks for the URL of the folder specified above. The URL should begin with http:// and
end witha /.

Try it out

You need to have a static server already set up, of course. And you need a file-sharing connection
between the machine running Frontier and the machine running the static server. The details of setting
up a server and a file-sharing connection vary -- if you have any trouble with either task, consult the
documentation for your static server and for your operating system.

Then set up your prefs in the Frontier Admin site. Then go to a Manila site on your Frontier server and
upload a picture. You can verify by looking on disk to see that the file was indeed written out. View
the source of the pictureViewer page to see the URL to the image: it's not a /picture$ URL that you're
used to, it's now a URL to a file on your static server.

The important thing to know that your users may not notice a change at all -- unless they notice that
their site seems faster, or unless they actually notice that URLs for pictures are different. From the
point of view of the Manila user, nothing fundamental has changed, one still uploads pictures the
same as before and embeds pictures the same as before.

Gems

The Gems feature allows editors to upload files of any type -- movies, sound files, zip files,
spreadsheets, etc. -- to their Manila websites. These files will be written to disk, and are intended to be
served by a static server like Apache or IIS.



Where Gems are Stored

Uploaded files are stored on disk. You specify the location of the files from the Static Files settings
page in the Frontier Admin site.

Three options

There are three most common configurations. Before getting started, decide which one applies to you.
1. Gems will be served by Frontier, from a sub-folder, such as www.mydomain.com/files/.

2. Gems will be served by Frontier, using a virtual domain such as gems.mydomain.com.

3. Gems will be served by another webserver running on another machine.

If you're using a server running on another machine, you'll need to make sure file-sharing is set up, so
Frontier can read and write files to that other machine's hard drive.

Serving Gems from a sub-folder of your website.

This is choice #1 -- you're serving Gems from a sub-folder, such as http://www.mydomain.com/files/.
In the Domains settings page in the Frontier Admin site, you can add a new path to /files/ and to the
mydomain.com domain or default that has a path as the path to the files folder, for example,

C:\Frontier\Guest Databases\www\myStaticSite\.

This tells Frontier that, when a URL begins with http://www.mydomain.com/files/, Frontier will look
in C:\Frontier\Guest Databases\www\files\.

It's important to note that we used "files" instead of "gems" because using "gems" for the name would
render the Gems feature unusable. This is because the URL for the Gems list page in the top-level
Manila site is http://www.mydomain.com/gems/. When picking a name for your Gems folder, use a
name that is not the path to any pages in your Manila site.

Serving Gems using a virtual domain

This is choice #2 -- serving Gems from Frontier using a virtual domain.

You can also set this up from the Domains settings page, just create a new domain and for the object
use the path to the files folder. Examples might be gems.mydomain.com or files.mydomain.com.

This should be identical to the path you entered in the Static Files settins page in the previous section.
Remember to include the trailing slash.



Serving gems using a server other than Frontier
This is choice #3 -- serving Gems from a server other than Frontier.

In this case, Gems are still uploaded via Manila, via Frontier -- but another server such as Apache,
WebSTAR, or IIS serves the files. One reason to do this is that Frontier is optimized for serving data
from the object database, rather than from disk, while many other servers are optimized for serving
files from disk.

You will need to set up file-sharing: the hard drive of the external server should be mounted on the
machine running Frontier. This is necessary because Frontier needs to be able to save incoming files
to that server's hard drive.

For example, if you want to use IIS on a second machine, mount the IIS server's www folder as disk
E:, and tell Frontier to save files to E:\\gems\\ instead of to the local disk.

In this case, you don't need to set up anything in the Domains settings page -- but you do need to
configure your external server. Consult the documentation for that server.

Domains

You can manage virtual domain hosting on the Domains page. Virtual Domain Hosting is a common
feature of modern webservers. Here's how it works: When a web browser requests a page from the
server, the request includes a header which specifies the domain name the page is being requested
from.

Since the browser sends the domain along with the request, it's possible to serve different content,
based on what domain name the request is directed to. In short, one webserver can serve many
different sites, even though all of the sites are served on the same IP address, over the same physical
connection to the Internet, and using the same server software.

Adding a domain

Domain is the domain name for virtual hosting, for example if Frontier serves both
mysite.myserver.com, and myothersite.myserver.com, then you can determine which domain will host
the site by typing the relevant domain name. Another valid value is default, which means the site will
be served for any virtual domain that's not explicitly defined in config.mainResponder.domains.



Path is the relative path for the site underneath the domain, so for example if you want to install a site
at http://www.myserver.com/mysite/, then enter www.myserver.com for the domain, and /mysite/ for
the path.

Object may be any of the following:

1) The address of a website in any database, for example myManilaSite, or myToolWebsite.

2) The path to a folder on disk, for example, C:\Frontier\Guest Databases\www\myStaticSite\

3) A redirect, which takes the format, http://www.scripting.com -- This will redirect to scripting news,
for any request that comes in at the domain and path you specified.

See also
xml Site Tree

config.mainResponder.domains

Security

On this page, you can configure Frontier's global security settings -- what type of authentication to use
for the Admin website, whether directory/script listings and running scripts are allowed by default
(which can be overridden on a site-by-site basis), whether to restrict access by client IP address and to
use an encrypted cookie format.

Admin security level

The Admin website uses HTTP Basic authorization. You can instead use varying levels of digest
authentication, which is stronger. (For technical details, see HTTP Authentication Schemes.)

Not all browsers support digest authentication, so it's not enabled by default.

There are four security levels, Basic only, Basic or Digest, Digest Only, Digest with replay protection.
If you can't access the Admin site in your browser after changing the security level, you can reset the
security level to Basic only. In the Frontier application, jump to config.mainResponder.prefs. Set
securityLevel to 0.

Directory and Script Listings

Directory listings will render listings of tables and folders.

Script listings will display the source code of scripts that aren't rendered.
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Scripts to run will run scripts when the request points to a script object that isn't rendered.
Blocking HTTP requests

You can choose to block all HTTP requests to your server except for the specific IP addresses listed in
the text box.

Membership
The encrypted format does not store passwords in membership cookies. Instead it hashes the

password, plus additional information, to make membership more secure. By default this setting is
enabled (For technical details, see Encrypted Cookie Format.)

Themes
When you've found a Manila site with a theme you want to install on your server, first download the
theme file, then put it in the /Guest Databases/ops/themes/ folder. If the folder doesn't exist, create it.

At the beginning of every minute, Frontier checks for new and updated themes in the themes folder
and installs any that it finds.

About theme files

Theme files are Frontier files, they're exported tables. The themes loader first validates the table
structure of the file to make sure it's a valid theme file.

Then it performs security checks. It makes sure there are no script objects in the theme file. It makes
sure that all the macros called in the various templates are legal macros on your server. Any illegal
macros are neutered.

config.manila.themes

Themes are stored in config.manila.themes. The name of the theme file matches the name of a table in
config.manila.themes. (Minus the .fitb suffix.)

The name of a theme's table is usually similar to the name that's displayed in the themes site prefs
page. However, it may not be the same. The theme's display name is stored at
[theme].info.displayName.

You can edit your installed themes directly: config.manila.themes is your space.

Disabling a theme

You can disable a theme by going to the Manila > Themes preferences page in the Frontier Admin
site. Then the theme won't appear on the change Themes pages on Manila sites on your server.
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You can delete a theme entirely by deleting its table from config.manila.themes. However: make sure
you don't still have it as a file in the /Guest Databases/ops/themes/ folder -- because it will be re-
imported at the top of the next minute.

The Default theme

A theme named Default is required. If you want only one theme enabled, make it the Default theme.
As with other themes, you're free to edit it. If you want every site on your server to start with the same
theme, this is how you do it.

manilaData.themes

This table contains UserLand-supplied themes. Themes in this table are automatically copied to
config.manila.themes.

Don't make changes to manilaData.themes, make changes in config.manila.themes. If you want to
disable a UserLand-supplied theme, set flIEnable to false for that theme's table in
config.manila.themes.

See Also

How to Create a Theme explains how to create a theme and make it available for downloading.

HTTP logging

You can monitor HTTP traffic on your server and you can also setup Frontier to log to a text file using
a format that can be analyzed by most logfile analysis programs.

The log is stored in a guest database. There's a new one each day. Look, in the Window menu, for a
database whose name is the current date, something like 2000-08-01.root. Look for a table named
mainResponder inside that database.

Steps

1. Open the Admin Site and at the top of the page click the Settings link.

2. Click the Logging and Statistics link.

3. Check the box to log every HTTP request.

4. With logging turned on, you can see the most recent requests on the Readouts page. You can click
the HTTP Server Log link on the Readouts page to see more recent HTTP requests.
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Logging to a text file

You can log to a text file instead, or also, if you prefer. Text file logs are in Common Log format,
which can be read by stats analysis programs such as Analog.

On the Logging and Statistics settings page, check the box to "log HTTP requests in common log
format".

The logs will be saved to a sub-folder of the logs folder called "Common Log"

There's a new file generated each day. Files have names like 2000-07-11.txt. In other words, the file
name format is yyyy-mm-dd.txt.

Legal Macros

Most Manila sites are dynamic sites -- the pages are rendered from text, templates, and script code that
resides on your Frontier server. When a web browser requests a page from the server, Frontier pulls
all the pieces together, and churns out a page of HTML which is returned to the browser.

Pages in Manila sites can contain macros. Macros make it possible to include calculated elements in
your web pages and templates, and many of Manila's more powerful features build on macros.

Since Frontier's deep scripting language has the ability to modify just about anything on your server,
we provided a mechanism for specifying what macros are "safe". Any non-safe macros are
automatically "neutered" -- their code won't be executed when the page is rendered.

You can use the Legal Macros settings page to add to the list of safe macros through the admin
website. To make a macro safe just type its name and click a button. To remove a safe macro, check a
box and click a button. Safe macros are available to all Manila sites, and indeed all dynamic sites, on
your Frontier server.

See also

Safe Macros Guidelines

Database Subscriptions

Frontier has a pair of features which work together to make it easy for multiple to work together on
changes to a single database: WebEdit and Subscribable Databases. WebEdit is a client-server
application that runs in Frontier, which allows a group of people to work on a database -- a website or
scripting project.
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The Subscriptions feature allows you to publish a database and let other people to subscribe to
changes made to the database. It uses the same mechanism as updates to Frontier.root.

The two features work together -- when a change is checked in to a subscribable database using
WebkEdit, it's automatically added to the updates stream for the database.

The Database Subscriptions page lets you easily choose which databases you want to enable
subscriptions for. Check the box next to the database's name, click the submit button, and you're done.

Server administrators can also see at a glance how many parts are in the updates stream for a given
database.

Home page updates and most-read sites

You might want to add pages that display the most read sites on your server and the most recent home
page updates.

Updates

To create a page listing the most recently updated home pages on your server, create a new story,
create a path for it like /updates (or whatever you want), and add this macro to the page:
{hostingSuite.viewUpdates (20)}.

The number 20 is just an example -- this number specifies how many updates to show in the list.

Other ideas: you could include this macro on the same page with your Create a Manila Site form. Or
you could put it in the template of that site.

See hostingSuite.viewUpdates at Macros.UserLand.Com for more about this macro.

Most Read Sites
Like the recent updates report, this report is generated by a macro.

There are two macros: one displays most read sites all-time, the other displays most read sites for the
day before.

Create two new stories. In one, include the most read sites macro by typing
{hostingSuite.viewMostReadSites ()}.

In the other, include the most read sites for the day before by typing
{hostingSuite.viewMostReadSitesYesterday ()}.
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For more about these macros, see Macros.UserLand.Com on hostingSuite.viewMostReadSites and
hostingSuite.viewMostReadSitesY esterday.

keepFrontierRunning

Some system operators like to relauch all their server software every 24 hours, and it's actually a good
practice with Frontier if a server application tends to run low on memory. There are certain policies in
the Frontier kernel that cause large tables to remain in memory for the life of the program. So by
quitting and relaunching Frontier, you can start fresh, and this can boost the performance of Frontier
Servers.

Keep it simple. If you're a new server operator, don't use the sample script. It'll make your life more
complicated. On the other hand, if you're an experienced developer and are willing to babysit this for
a few weeks until you get your Frontier-quitting script working as you like it, quitting and restarting
Frontier can in some cases improve the performance of your server.

You can find the flaunch.exe and keepFrontierRunning.sit files in the \Extras\keepFrontierRunning\
sub-folder of the Frontier folder.

flaunch.exe on Windows

In this folder is a Windows application, flaunch.exe. It's a faceless app that checks periodically to see
if Frontier is running, if it's not, it launches it. With this app running, you can safely call
fileMenu.quit, from a scheduled script, to cause Frontier to restart periodically.

Here's a script that runs from the user.scheduler.everyMinute table. It quits after 10,000 hits, and only
when the server isn't busy executing hourly tasks or serving users. The basic design is to get Frontier
to quit when it's not especially busy. No doubt more sophisticated algorithms are possible.

if systemenvironnent.i sWndows //make sure the flaunch app is running
if not sys.appisrunning ("flaunch. exe")
local (frontierPath = Frontier.getProgranPath ())
local (frontierFolder = file.folderFronPath (frontierPath))
local (flaunchPath = frontierFol der +
"Extras\\ keepFrontierRunni ng\\wi n\\fl aunch. exe")
I aunch. appW t hDocunent (flaunchPath, frontierPath)

if user.webserver.stats.hits > 10000
if Frontier.countThreads () == 1
local (day, nonth, year, hour, ninute, second)
date.get (clock.now (), @ay, @month, @ear, @mour, @rinute, @econd)
if minute !=0 //don't quit while hourly tasks are running
fil emenu. save ()
filemenu.quit ()


http://macros.userland.com/hostingSuite/viewMostReadSites
http://macros.userland.com/hostingSuite/viewMostReadSitesYesterday

AppleScript on Macintosh

It's a very simple AppleScript that, once every 10 seconds, checks to see if Frontier is running. If not,
it launches it.

Here's a script that runs from the user.scheduler.everyMinute table. It quits after 10,000 hits, and only
when the server isn't busy executing hourly tasks or serving users. The basic design is to get Frontier
to quit when it's not especially busy. No doubt more sophisticated algorithms are possible.

if user.webserver.stats.hits > 10000
if Frontier.countThreads () == 1
local (day, nonth, year, hour, ninute, second)
date.get (clock.now (), @ay, @onth, @ear, @our, @rinute, @econd)
if minute !=0 //don't quit while hourly tasks are running
fil emenu. save ()
filemenu.quit ()

Using Frontier alongside other web servers

Frontier has a built-in web server. Since all web servers listen for requests on at least one IP address,
usually on port 80, Frontier 's web server will likely conflict with other web servers you have installed
on the same computer.

If you're already running a web server you will have to work out the port conflict, since only one
server can run on a given port.

There are a number of possible solutions to this problem.
Use separate computers
The easiest option is to run Frontier and your other web server on separate machines.

Before you install Frontier, make sure to disable any other web server running on the machine or
install Frontier on a machine on which no other web server is installed.

Use separate ports

Configure Frontier to listen on a port other than port 80. This is the easiest solution, but your websites'
URLSs will have a port number in them, like http://www.yourdomain.com:8080/.

Open the Frontier application and stop the web server if it's running, choose Web->Web Server-
>Stop. Then choose Web->Web Server->Set Port. A common alternate port is port 8080. Enter 8080
and then restart the server.

If you choose this option, you will need to change the URL of any of the default sites to include the
new port. Also, update the base domain for new sites on the Hosting settings page in the Frontier
Admin website so new Manila sites include the port number in the URL.



http://frontier.userland.com/stories/storyReader$10601

If you want friendlier URLs for your Manila sites, you can configure static rendering. This will make
Manila write its web pages to a sub-directory of your other server's web folder, and your other web
server will serve the sites.

You edit using the port 8080 URLs as above, and your readers see the sites as served by your non-
Frontier web server on port 80.

There are disadvantages to this approach: you can't use macros to generate dynamic elements in your
pages (elements that change with each page-load), and Frontier will not count page reads on the static
server.

Serve static sites with Frontier

You can use Frontier instead of your other web server to serve your static websites. This approach
assumes you're not using CGls, or SSI.

On the Domains setting page, you can setup Frontier to serve pages from disk.

Mac OS X and Apache
There are two more solutions if your server is running MacOS X and Apache:
1. You can configure MacOS X to use two IP addresses, and then set up Apache to listen on one IP

address on port 80, and Frontier to listen on the other IP address, also on port 80. This is a little
complicated to set up, but will give nice results.

2. If multiple IP addresses are not an option, and you need to keep Apache running, then it's possible
to configure Apache to act as a proxy for requests that are intended for Frontier/Manila. This requires
that you do a little work in your apache.conf file (Apache's configuration file), to tell Apache how to
forward the requests. There's some additional tips on this setup from the Frontier for Mac OS X site.

The advantage of the second approach is that you get seamlessness between Frontier and Apache
running on the same IP address (or domain name), but the disadvantage is that depending on how
you'll use Frontier, you'll need to add a few lines to apache.conf for each new site you create.


http://frontier.userland.com/manila/staticRendering/
http://frontier.userland.com/domains
http://frontier-osx.userland.com/discuss/msgReader$445?mode=day
http://www.wiredfool.com/docs/apacheProxy
http://frontier-osx.userland.com/discuss/msgReader$945?mode=day

Advanced Features

Search Engine
Frontier includes a built-in search engine that you can easily configure using the Admin website. The
search engine can index both Manila sites and Radio sites.

The admin website and the default Manila site each include a search field on their home page when
the search engine is enabled, allowing you and your users to quickly find data stored on the server.

Search results are presented in a format similar to Google's results, with search terms hilighted in bold
text if you store the full text of indexed pages.

It's also easy for editors to add a search field to their own home pages, so they or their readers can
search content in the site, or across the entire server.

Turning on the server
1. Open the Admin Site and at the top of the page in the menu click Settings.
2. Under Server Settings, click Search Engine.

3. Check the first box to enable the search engine server.

ServerMonitor

The ServerMonitor Tool is useful for people who run more than one server. It monitors up-time and
performance of all your servers, so you can quickly find out if all your servers are running and how
well they are performing.

If a server goes down, email notification is automatically sent to the server manager(s) alerting them
of the situation.

ServerMonitor can track uptime for any HTTP server. When monitoring another Frontier server which
has ServerMonitor installed, additional information like the version of Frontier on the server, the
number of requests in the RPC queue, and the amount of free disk space will be recorded and
presented on the ServerMonitor home page.

For any of the Frontier servers you're monitoring, you can click the IP address to go to the admin site
for that server.



How to add a server

1. Open the ServerMonitor tools home page.

2. Enter the domain or IP address and the port of the sever.

3. If you are connecting to another Frontier server, you can choose XML-RPC or SOAP. If you are
connecting to another Web server, choose HTTP.

If it's a Frontier server, use "/RPC2" for the path or if you are using the HTTP protocol use a path to a
page that ServerMonitor will retrieve to check the performance of the server.

Radio Community Server
Radio Community Server is a software application that makes it possible for individuals or
organizations to host communities of Radio users.

Radio Community Server now ships with Frontier. As part of installing Frontier RCS is configured
automatically with defaults that can be used 'out-of-the-box'.

RCS can optionally index all upstreamed pages, OPML documents and RSS files using Frontier's
built-in search engine. A new prefs page enables or disables the feature.

Manila site statistics are optionally included in RCS' updates and rankings pages. Your Manila and
Radio users all participate in a single community.

Radio Hosting

Any Manila site can act as a host for comments about posts on a Radio UserLand weblog. Since Radio
UserLand sites are static files, a dynamic system is required for a feature like comments, and Manila
makes good sense.

See also

RCS.UserLand.Com



http://127.0.0.1:5336/serverMonitor/
http://rcs.userland.com/

WebEdit
WebkEdit is an extensible client-server that allows remote access to your databases, from one copy of
Frontier to another. It's a set of RPC handlers that that handles requests from the webEdit client suite.

WebkEdit is built into Frontier.root, every Frontier user has both a WebEdit client and a WebEdit
server. Neither the client or server is operational until you turn them on, for security reasons.

Common WebEdit operations include Get from Server, Check Out, Check In, Send to Server, and
Delete Object.

Managing the WebEdit server

From the WebEdit settings page in the Frontier Admin site, you can enable the WebEdit server or add
and remove WebEdit users. You can also view which objects have currently been checked out or to
force check-in an object.

Using WebEdit

From the copy of Frontier acting as the client, open the WebEdit menu from your Suites menu.
Choose "New Server" from the WebEdit menu.

A dialog box opens for you to type in the host name of the server, as in www.myserver.com.

The prefs for that server will open. Set the port if it's other than 80. Set your username to whatever
your username on the remote server is.

You can set your password if you want, or leave it blank to be prompted every time.

Choose "Set Current Server..." from the WebEdit menu and choose the name of the server you just
set. You can have multiple servers, and whenever you want you can switch between them with this

command.

You can also see what the current server is by looking at the menu -- the current server has a
checkmark next to it.

Whenever you want to change your server prefs, choose "Edit Server Prefs."
How to make the WebEdit menu permanent
Many people choose to make the WebEdit menu a permanent part of their Frontier menubar.

To do so, jump to user.menus. Add an item called WebEdit. It's value should be an address,
@webEdit.menu.



To re-build your menubar and get the WebEdit menu to appear, type ctrl-minus on Windows or cmd-
minus on Macs.

The #webEditServer attribute

You can put a #webEditServer attribute in your database. It works like website framework directives,
it's inherited.

It should be a string, the name of the server to use when using WebEdit commands with this database.
The #webEditServer attribute, when present, over-rides the current server setting.

This is designed to reduce the number of times it's necessary to manually switch servers via the
WebEdit menu.

Getting an object from the server

Put your cursor on an object. Choose "Get From Server" to get the version of the object that's on the
server.

If you don't have a copy of the object you want to get, create a dummy object in your root first, then
choose "Get From Server."

Checking out an object

To mark an object as yours, put your cursor on the object and choose "Check Out." The server will
then not allow anyone else to check out or update this object on the server.

When you check out an item, you get the version that's on the server. It over-writes the version you
currently have.

Checking in an object

When you want to send an object to the server, use the "Check In" command. You can check in any
object you've checked out. You can't check in an item that you didn't first check out.

The one time you can check in an item without first checking it out is when the item is new, it doesn't
already exist on the server.

Send To Server

This command sends an object you've checked out back to the server without giving up your custody
of the object.



Other commands
Render on Server is used for sites using the fileWriters framework, you can render individual pages on
the server with the command. Returned will be the URL of the page, and that URL will be opened by

your web browser.

Undo Check Out releases your lock on the object on the server without your having to check your
copy back in.

Delete Object allows you to delete an object on the server. For safety reasons, deleted objects are
stored in /Guest Databases/ops/WebEdit Deleted Objects/ sub-folder of the Frontier folder. (Note that
this location may change.) This command presents a confirmation dialog box before sending the
delete command.

Guest databases

You can check in and out objects, get objects, and render objects residing in guest databases on a
server.

Your local guest database should have the same file path, relative to Frontier, that the guest database
on the server has.

For example, if your guest database is at Macintosh HD: Apps:Frontier:databases:gdb.root, then the
corresponding database on the server might be at D:\Frontier\databases\gdb.root.

Change note dialog
If you set fINotes to true for a server in the user.webEdit.servers table (creating the entry if necessary),
then when you check in an item or do a Send To Server to that server a dialog box will prompt for a

short change note.

If you're making changes to a guest database that has a #changes table, and mainResponder is
installed, then the why field of each #changes table entry will contain the change note.

WebEdit callbacks

All WebEdit operations support callbacks. Each handler in webEditServer.rpcHandlers.webEdit now
has two callbacks -- a callback for before the action is performed and one for after.

These callbacks all take the same parameters: adrObject, userName, time, and extraCallbackInfo. (The
last may be anything, such as a description field, but it's currently unused.)

Also -- and this is important -- the paramtable is in scope for these callbacks, thanks to callScript. So
you can get IP addresses, cookies, and other info about clients.

Any callback can generate a scriptError to prevent what would normally happen next from happening.



This set of callbacks can form the basis for customized source code control and notifications.

Here's an example of how to get the entire param table from within a callback script:
on testCallback (adrObject, username, time, extraCallbackInfo)

local (pta)

pta = parentOf (code)

temp.params = pta”

return (true)

A copy of the params table would be stored at temp.params.

Client verbs

In the first version of WebEdit, you couldn't call any of the verbs directly, they relied on getting the
current cursor address. Now the menu commands have been separated from the actions, so you can
call, from your own scripts, verbs such as webEdit.checkOutObject and so on. (Note: verb names and
parameters may change before this new version of WebEdit is finalized.)

Notes

If the server is running the old version of WebEditServer, fINotes in the change note dialog must be
false, as the old server doesn't expect this parameter.

The WebEdit client can present dialogs, which is the default, or display messages in the About
Window instead. Toggle this by setting user.webEdit.prefs.flDialogs.

You can change the CheckOut timeout setting on your server by editing
user.custody.prefs.timeOutMinutes.



Troubleshooting

Referer error

"Sorry! There was an error: Can't evaluate the expression because the name "referer" hasn't been
y p

defined."

Manila checks the referer of requests for security reasons when you try to post a message or configure
your site.

If you are using the Opera Web browser or Internet security software like Zone Alarm Pro, you may
see the referer error message since they can both be configured to prevent the referer from being sent.

Some hardware proxy servers or firewalls may also remove or remove your referer.

To enable the referer data from being sent in Zone Alarm Pro, open the options and uncheck the
Remove Private Header information in the Cookies tab.

In Opera, open the preferences and choose Privacy. Check the box for Enable referrer logging.

In Norton Internet Security or Norton Personal Firewall, you can follow the instructions on this page.

Can't login to a site

If you try to login to your Manila site as a member or editor, but don't receive a login screen and see
the same page you would see if you weren't logged in you may need to enable cookies in your
browser.

Manila uses cookies to identify if you are a member or editor of a site, you should check the browser's
documentation on enabling the feature.

Restore default template
It's possible to edit a template in such a way that the site is unusable -- certain types of typos will
make the HTML in the template un-renderable by a browser.

Since you use the site to edit the site, when there's a problem with the template, you can't fix the
problem.


http://service1.symantec.com/SUPPORT/nip.nsf/735050b77b1fcece88256bc7005c3bc6/b9b47ad7eddd343b88256c6b006a85a8

The template restoration page does not use your template, so it's always viewable. It's at a URL like
this:

http://www.yourdomain.com/admin/restoreTemplate

Reset webmaster password for Frontier Admin site
You can reset the password for the webmaster by opening the Frontier application and choosing
Server->Set Admin Password. Enter the new password and click the OK button.

Note: You can edit the password and other information for other administrators to the Frontier Admin
site from the Administrators Settings page.



Reference

Programming pointers

A simplified but useful way to look at Frontier is as a layer cake. On top is Manila, the easy-to-use,
browser-based content management system -- Manila is the icing.

Here are the main layers underneath Manila:

mainResponder implements discussion groups, website membership, calendars, browser-based
editing, and more. Manila relies on mainResponder heavily. mainResponder is implemented in
mainResponder.root. (Look in the apps folder in your Guest Databases folder. Also note that
manila.root is there, too.)

Frontier's XML services implement the cross-platform, cross-network SOAP and XML-RPC
protocols (both of which UserLand co-authored). Manila's preferences pages are implemented by
prefs.root, an application that turns XML into HTML forms. (See the www folder.) Lower-level
support for things like outline serialization and XML text parsing is present too. Manila stores some
data as XML, and is itself scriptable via SOAP and XML-RPC.

The webserver framework is what makes Frontier a Web server. Parts of the webserver framework,
particularly the TCP networking, are handled by the kernel (the Frontier application). The webserver
framework has a plug-in architecture called "responders" -- and that's how mainResponder got its
name. (It's the main responder.) SOAP and XML-RPC also have webserver framework responders,
since HTTP is the main method of transmitting SOAP and XML-RPC messages.

The website framework implements templating, macros, automatic URL expansion, includes, outline
rendering, and more. In a sense, Manila is a friendly front end to the website framework.

The kernel, the Frontier application itself, is the multi-threaded runtime for all of the above. It
compiles and executes scripts, does TCP networking, manages database files, displays outlines,
presents the user interface, and so on.
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Reference

Frontier Developer's Directory

All the documentation for Frontier and Manila is included in the Frontier directory.
Object database
The object database is the storage system for the scripts and data that power Frontier.

Writing Scripts

How to write and debug scripts and where to store them.
Scripts are outlines

Like outlines and the object database, scripts are outlines too.
The UserTalk Language

An introduction to UserTalk, Frontier's scripting language.
XML data storage

The object database stores XML data in compiled format.
Frontier: The Definitive Guide book

Read Matt Neuberg's Frontier book online.

Frontier User's Guide

This manual is an introduction to the environment.
Website Scripting Tutorial

This tutorial gets you up-and-running with the website framework and writing macros and outline
renderers.

Frontier Discussion Group

A forum for asking questions about Frontier server management and software development.
Macros.UserLand.Com

Manila's built-in macros.
DocServer

Frontier's built-in verbs.
Samples.UserLand.Com

Sample scripts and applications for Frontier.
Plugins.UserLand.Com

Documentation regarding the Manila plug-ins format and links to plug-ins created by Frontier
developers.

Search
Search Frontier and Manila documentation.
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